A Principled Technologies report: Hands-on testing. Real-world results.

Free up rack space by replacing old servers and storage

A 2U Dell™ PowerEdge™ FX2s and all-flash VMware® VSAN® solution
powered by Intel® Xeon® processors and Intel SSDs can reduce hardware in

your datacenter

New server and storage technologies can help improve your business,

potentially saving you time and improving your customer experience.

T

Understanding the benefits of specific technologies can make choosing your

next datacenter upgrade easier. T

T

At Principled Technologies, we compared five-year-old servers and storage =
to a Dell PowerEdge FX2s chassis filled with Intel processor-powered

PowerEdge FC430 and FD332 nodes featuring Intel solid-state drives Ean
(SSDs) and running VMware Virtual SAN (VSAN). Both solutions ran the
same mixed workload of database, email, and simulated file server work.
With three FC430 nodes, the newer Dell and VMware solution ran more
workloads in 2U than the older solution ran in 8U. When we added a fourth
FC430 node, the Dell and VMware solution did 16 times the work of the

legacy solution. What's more, the VSAN virtual storage reduced the need for Do the work of

16

and storage. legacy solutions

multiple dedicated storage arrays. With this solution, your business can do
significantly more work in less rack space than you could with older servers

We ran the Dell Performance Analysis Collection Kit

performance requirements.

(DPACK) to gather information on the performance of the new environment. By
running DPACK in your own datacenter, you can characterize your environment's
performance and resource utilization, plus identify bottlenecks for
troubleshooting. Then, take a look at the DPACK data for our newer solution
to see its performance metrics. In your environment, using DPACK can
highlight upgrade opportunities and help you better understand specific

Get performance data with DPACK
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Replace aging hardware to enhance your datacenter

Older servers and storage can obstruct growth

Growing businesses must add users and applications out of necessity. Legacy servers and storage can’t always support
these additions. Your business can expand its datacenter with repurposed hardware to meet the demands of growth, but

that requires physical space, a valuable commodity. A larger physical footprint translates to a greater power demand,
potentially increasing those costs.

Even when older servers and storage can meet certain demands of a growing business, they can still have drawbacks.
For example, IT administrators may have to devote more time to updates and maintenance. This can drive up labor costs

for your IT staff. In addition, older hardware lacks the speedy new processors and helpful management features of newer
technologies.

A Dell PowerEdge FX2s and VMware VSAN solution in your datacenter presents a real opportunity to improve your
business and its functionality.

Run many applications in a small datacenter footprint

In hands-on work in our datacenter, an upgraded Intel processor-based Dell PowerEdge FX2s and VMWare VSAN
solution with three server nodes did 10 times the work of a legacy solution. The legacy solution occupied 8U of rack
space, while the FX2s and VSAN solution required only 2U to run the workloads. What's more—scaling up with another
FC430 server node allowed the solution to do 16 times the work of the legacy solution without increasing the necessary

rack space.
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With this upgrade, your company could consolidate workloads from multiple departments. For instance, we centralized
multiple Microsoft® Exchange mail servers, Microsoft SQL Server® databases, and file servers into one location while

keeping them separate on VMs. This means you can grow your business without bloating your datacenter with older
repurposed hardware.

What is VSAN? Features new to VSAN 6.2

VMware VSAN makes storage a virtual o
resource for your applications. Embedded in
the hypervisor of VMware Hyper-Converged
Software solutions, VSAN clusters server-

Deduplication and e Support for pure IPvé
compression

® RAID-5/6 erasure coding

attached flash devices and hard disks e Enhanced Virtual SAN
to create a shared datastore. For more management
information, visit the

e Software checksum
e Client cache

e Sparse swap

e Quality of Service features
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https://www.vmware.com/products/virtual-san

Make all of your resources available to applications

Implementing a VMware virtual environment on an FX2s solution lets you consolidate workloads and save rack space by
removing the need for physically separate servers and storage. VMware VSAN takes those benefits a step further: using
VSAN to pool physical storage can help your applications better utilize the available storage resources.

A virtual vSphere environment allows your business to run multiple, separate workloads on a single physical server, such
as an FC430 in an FX2s chassis. Additionally, the virtualized workloads use only the portions of the physical resource
you've allotted to them. If one VM maxes out their allotted resources, the other VMs can still use their portions.

VMware VSAN can leverage the storage resources of the FC430 and FD332 nodes as a shared storage pool to help
applications perform better and more efficiently. You can provision storage on a per-VM basis by using policies in VSAN.
These policies help balance storage without the use of LUNs or RAID configurations.

Approching physical resources this way means it's less likely that idle resources will go underutilized while other resources
bottleneck, a common problem in legacy hardware. In a traditional legacy setup, IT may assign a single application to a
single server. That application uses the hardware resources it needs while other resources sit idle. This problem grows as
datacenters swell with hardware; if the organization splits into multiple departments with distributed IT staff, it can get
even worse.

Add resources to keep up with business

The FX2s chassis houses up to four FC430 server nodes and up to two FD332 storage nodes. Scaling up compute
resources is straightforward — simply add and configure another server node.

Scaling storage with VSAN is straightforward, too. A cluster can scale out with the addition of an FC430 or FD332 node,
or an exisiting cluster can scale up when you provision more capacity.

In our datacenter, we added a fourth PowerEdge FC430 node to the FX2s and VSAN solution. Scaling up immediately
added more compute, networking, and storage resources, boosting the amount of work the solution could do. The
scaled-up FX2s and VSAN solution did 16 times the work of the legacy solution.

Every business relies on its datacenter to help meet its full potential. Scaling the FX2s and VSAN solution could let you
handle that growth with ease.

Beef up the PowerEdge
FX2s with VSAN license
versatility

With the VMware VSAN 6.2 license, you gain
the flexibility to use traditional external SAN in
addition to the storage of VSAN. As the FC430
servers still had compute resources available,
et e N il we increased the storage capacity of our
P | | 7 scaled-up, four-server-node FX2s solution by
—— adding an all-flash Dell Storage SC4020 array.
We connected the array to the chassis via fibre
channel. This extended solution was still half
the size of the legacy environment.

We saw an improvement in the amount

of work the solution could do. The added
storage gave the solution the capacity to do
32 times the work of the legacy environment,
doubling our four-node performance.
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Keep your favorite parts of your current
infrastructure

By upgrading to newer servers and storage
technologies, you gain the benefits of the latest
innovations while maintaining the hardware features
on which you rely, including the flexibility of general
purpose servers and centralized storage features
such as snapshots and compression. At the same
time, your company has new opportunities for added
density, faster workload processing, and better
resource management.
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This solution also enables you to use a management
tool that may already be familiar to your IT staff:

Dell OpenManage™ Essentials (OME). If use OME
to manage a Dell server and storage infrastructure CTET TG o] T s
from five or six years ago, the new version of OME

will allow you to manage your new servers similarly. Newer hardware, such as the Dell PowerEdge FX2s chassis and
PowerEdge FC430 server nodes powered by Intel Xeon processors, can take advantage of the new features and
functions in the latest version of OME while maintaining the familiar management interface your IT administrators may
already use. In previous studies, we found OME can save time and improve efficiency in datacenter management.” These
advantages may help enable a more straightforward transition from the old hardware to the new.

Take a look at DPACK

DPACK measures the throughput, disk I/O, memory, capacity, and CPU utilization of your servers and storage. It reports
this data to help you better understand what hardware you'll need when you upgrade.

@ Compliant Systems @ Non-Compliant Systems

@ Non-Tnventoried Systems @ Issues and resolutions

You can use the DPACK online viewer to review your results in two ways: Aggregate or Individual. Aggregate results offer
performance data for the full environment, while Individual results provide numbers for a specific server. When we ran
DPACK on the new Dell and VMware solution, we viewed Aggregate results.

In addition to simply running DPACK in your own environment, you can contact a Dell salesperson who can help you
better understand your DPACK results and choose a solution that best fits your needs. We did not test this service.

~@ ——— .
i
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How we navigated the path to an upgraded datacenter

Our legacy environment

We created our legacy solution to approximate an infrastructure that a small enterprise might have
purchased five or six years ago and still use today. This bare-metal (non-virtualized) environment
contained three Dell PowerEdge R710 legacy servers with one legacy Dell EqualLogic™ PS6110

storage array. Appendix C has complete details on the solution.

Our upgraded environment

Our upgraded environment represents a possible next step for an enterprise moving from the legacy environment we
chose. It contains newer products with an architecture and functionality similar to those in the legacy environment.

Our new solution consisted of a Dell
PowerEdge FX2s chassis containing
three and then four Dell PowerEdge
FC430 server nodes, powered by
two Intel Xeon processors E5-2680
v4, and two all-flash Dell PowerEdge
FD332 storage nodes each using
four Intel DC S3710 SSDs for caching
and twelve Intel DC S3510 SSDs

for capacity. The nodes ran VMware
Virtual SAN to pool the physical
storage of the solution. In the final
test phase, we added one all-flash
Dell Storage SC4020 array powered
by an Intel Xeon processor E3-1265L
V2.

We used VMware vSphere 6 for the
hypervisor with VMware vCenter
Server™ and VMware vRealize®
Operations Manager™ for hypervisor
management. This tool provides

customizable dashboards you can use
to analyze risk, monitor capacity issues, and check on your virtual environment’s health.
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See Appendix C for more details.

On the legacy environment, each application of the mixed workload had a dedicated server. We tuned each application
to its maximum performance while maintaining acceptable thresholds for storage latency—a measure of how fast storage
can complete a request. For our purposes, those thresholds were under 20ms.

Then, we virtualized all legacy application servers on the upgraded solution and increased the number of VMs in sets
until we reached 80 percent utilization of at least one hardware resource. In this case, that was storage capacity and

allocated RAM. As we added storage capacity and RAM, we saw an even higher consolidation ratio because CPU and
storage latency thresholds were not at full capacity.

To capture data on the upgraded environment's performance, we ran DPACK. (For our DPACK results, see Appendix D.)

D il £
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Our workloads

We generated the workloads for each application using industry-standard tools.
For a database, we chose Microsoft SQL Server 2014 running a DVD Store 2
workload; for email, we chose Microsoft Exchange 2013 running a Microsoft
Exchange Load Generator 2013 workload; and for file/print, we chose the lometer
tool, which generates synthetic data streams mimicking a file server workload. This
mixed workload reflects many companies’ operations.

Conclusion

You could see 16 times the work of a legacy solution by upgrading to the Intel
processor-based Dell PowerEdge FX2s and VMware VSAN solution we tested.
Plus, virtual storage allowed the FX2s and VSAN solution to use less space.
Ultimately, this increased performance means your business could consolidate
workloads from across your company, lower your power and cooling bills, and limit
future datacenter sprawl. On top of that, this solution could help avoid a decline in
quality of experience for your users. The list of potential benefits goes on and on.

Try running DPACK in your own datacenter, which can help you characterize

your datacenter’s performance requirements and potential bottlenecks. Then,
consider how the increased mixed workload performance from the Intel processor-
powered Dell PowerEdge FX2s and VMware VSAN solution could help your
business flourish.

1 See the Principled Technologies reports Systems management savings with Dell Open-
Manage on 13G Dell PowerEdge servers and Dell OpenManage Essentials: Improve
efficiency with fewer tools, more benefits.

2 http://en.community.dell.com/techcenter/extras/w/wiki/dvd-store
https://www.microsoft.com/en-us/download/details.aspx?id=14060

http://www.iometer.org/

Lo

DVD Store 2

We used DVD Store Version

2.1, or DS2.2 DS2 is a database
performance tool. It models an
online store where customers

log in, search for products, and
make purchases. It also performs
other actions, such as adding new
customers, to exercise a wide range
of everyday database functions.

Microsoft Exchange Load
Generator 2013

Microsoft Exchange Server is an
email application that businesses
use widely across multiple
industries. To test how well the
solutions could run an Exchange
server workload, we used Microsoft
Exchange Load Generator 2013
(LoadGen), which functions as a
sample Exchange workload and
simulates a large number of users
generating email activity.®

010
010

lometer

Many businesses use file servers, so
we simulated a file server workload
using lometer 1.1.% lometer uses
action profiles to perform input/
output (I/O) operations that
approximate data operations such
as reading files, writing files, and
updating files.
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http://www.principledtechnologies.com/Dell/13G_systemsmgmt_savings_1114.pdf
http://www.principledtechnologies.com/Dell/13G_systemsmgmt_savings_1114.pdf
http://www.principledtechnologies.com/Dell/OME_comparison_0615.pdf
http://www.principledtechnologies.com/Dell/OME_comparison_0615.pdf
http://en.community.dell.com/techcenter/extras/w/wiki/dvd-store
https://www.microsoft.com/en-us/download/details.aspx?id=14060
http://www.iometer.org/

On June 14, 2016, we finalized the hardware and software configurations we tested. Updates for current and recently
released hardware and software appear often, so unavoidably these configurations may not represent the latest versions
available when this report appears. For older systems, we chose configurations representative of typical purchases of
those systems. We concluded hands-on testing on June 29, 2016.

Appendix A — Test systems

Detailed configuration information for the server under test.

Server configuration information 3x Dell PowerEdge R710 4x Dell PowerEdge FC430

BIOS name and version Dell 6.4.0 Dell 2.0.2

Non-default BIOS settings N/A N/A

Operating system name and version/

build number Windows Server® 2012 R2 ESXi™ 6.0 Update 2
Date of last OS updates/patches applied  03/31/16 05/31/2016

Power management policy Performance Performance
Processor

Number of processors 2 2

Vendor and model Intel Xeon E5520 Intel Xeon E5-2680 v4
Core count (per processor) 4 14

Core frequency (GHz) 2.26 2.40

Stepping DO MO

Memory module(s)

Total memory in system (GB) 48 256

Number of memory modules 6 8

Vendor and model Samsung® M393B1K70DHO-YH? Samsung M386A4G40DMO
Size (GB) 8 32

Type PC3-10600 PC4-2133P

Speed (MHz) 1,333 2,133

Speed running in the server (MHz) 1,333 2,133
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Server configuration information 3x Dell PowerEdge R710 4x Dell PowerEdge FC430

Storage controller

Vendor and model

Cache size

Firmware version

Driver version

Local storage

Number of drives

Drive vendor and model
Drive size (GB)

Drive information (speed, interface, type)
Network adapter

Vendor and model
Number and type of ports
Driver version

Network adapter

Vendor and model
Number and type of ports
Driver version

HBA(s)

Vendor and model
Number and type of ports

Driver version

Dell PERC 6/i
256MB
6.3.3.0002

6.600.21.8

Western Digital® WD3000BKHG
300

10K, 6Gb SAS, 2.5" HDD

Broadcom® BCM5709C
4 x 1GbE

7.4.23.2

Intel Ethernet Server Adapter X520
2 x 10GbE

3.9.58.9101

N/A
N/A

N/A

Dell PERC S130
N/A
25.4.0.0015

6.606.12.00-10EM

LITEON IT EBT 60N9S
60

6Gbps SAS, 2.5” SSD

Broadcom BCM57810
2 x 10GbE

2.712.50.v55.6

N/A
N/A

N/A

Qlogic® QLE2562
2 x 8Gbps Fibre Channel

2.1.24.0-10EM
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Server configuration information 3x Dell PowerEdge R710 4x Dell PowerEdge FC430

Power supplies

Vendor and model Dell N870P-SO N/A
Number of power supplies 2 N/A
Wattage of each (W) 870 N/A

Configuration details for the FX2 enclosure.

Power supplies

Number of power supplies 2

Vendor and model number Dell D1600E-SO
Wattage of each (W) 1,600

Midplane

Chassis midplane 1.0

Chassis firmware

Chassis Management Controller 1.32.200.201601210012

Chassis Infrastructure 1.20.A00.201502058

IOM Coprocessor Firmware 13.0

I/O modules

Switch Dell PowerEdge 10 GbE Pass Through Module
Occupied bay IOM Slot A1, IOM Slot A2

Management modules

Chassis Management Controller slot 1 Chassis Management Controller Hardware X05
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Detailed configuration information for the legacy storage solution.

Storage configuration information Dell EqualLogic PS6110

Controller firmware revision

Number of storage controller modules
Number of drives

Drive vendor and model number
Drive size (GB)

Drive information (speed, interface, type)

V7.0.5 (R390599)

2 x 70-0477 (TYPE 14)
24

Seagate® ST9900805SS
900

10K, 6Gb SAS, HDD

Detailed configuration information for the VSAN storage solution.

Storage configuration information 2 x Dell PowerEdge FD332

Controller firmware revision

Number of storage controller modules
Number of drives

Storage disk 1

Drive vendor and model number

Drive size (GB)

Drive information (speed, interface, type)
Storage disk 2

Drive vendor and model number

Drive size (TB)

25.4.0.0015

2 x PERC FD332D

16

4 x Intel DC S3710

800

Write-Intensive, 6Gb SATA, SSD

12 x Intel DC S3510

1.2
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Storage configuration information 2 x Dell PowerEdge FD332

Drive information (speed, interface, type) Read-Intensive, 6Gb SATA, SSD

Detailed configuration information for the external storage array.

Storage configuration information Dell Storage SC4020

Controller firmware revision 6.5.2
Number of storage controller modules 2 x CT-SC4020
Number of drives 24

Storage disk 1

Drive vendor and model number 12 x Dell SanDisk LB1606R
Drive size (TB) 1.6

Drive information (speed, interface, type) Read-Intensive, 6Gb SAS, SSD
Storage disk 2

Drive vendor and model number 12 x Dell SanDisk LB406S
Drive size (GB) 400

Drive information (speed, interface, type) Write-Intensive, 6Gb SAS, SSD
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Appendix B — Methodology

Legacy environment

We used the following steps to configure our legacy Dell PowerEdge R710 mixed workload environment. We included
notes on the virtual disk settings where applicable because we also used these steps in the creation of the upgraded
environment's virtual machine.

Performing the initial OS install and setup

Installing Windows Server 2012 R2

Insert the installation media into the CD/DVD drive, and restart the server.

When prompted to boot from DVD, press any key.

When the installation screen appears, click My language is English (United States).
Leave language, time/currency format, and input method as default, and click Next.
Click Install now.

When the installation prompts you, enter the product key.

Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.
Check | accept the license terms, and click Next.

Nk W~

9. Click Custom: Install Windows only (advanced).

10. Select Drive 0 Unallocated Space, and click Next.

11. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
12. Log in with the password you set up previously.

Configuring the operating system

1. Enable remote desktop access.

2. Change the hostname, and reboot when the installer prompts you.

3. Set up networking:

Click Start->Control Panel, right-click Network Connections, and select Open.

Right-click the management traffic NIC, and select Properties.

Select TCP/IP (v4), and select Properties.

Set the IP address and subnet for the NIC, which will handle management traffic, and click OK.
e. Click OK, and click Close.

4. Install all available Windows updates. Restart as necessary.

o0 T W

Configuring the Microsoft Active Directory and lometer server

For the legacy environment, we created a large dedicated LUN on the Dell EqualLogic PS6110 storage for the lometer
workload file. For the upgraded environment, we added a 120GB VMDK for lometer to the AD VM using the Dell
Storage SC4020 datastore and the VSAN datastore.

Installing Active Directory and DNS services

Launch Server Manager.

Click Manage->Add Roles and Features.

At the Before you begin screen, click Next.

At the Select installation type screen, leave Role-based or feature-based installation selected, and click Next.

At the Server Selection Screen, select the server from the pool, and click Next.

At the Select Server Roles screen, select Active Directory Domain Services. Click Add Features when prompted, and click Next.
At the Select Features screen, click Next.

At the Active Directory Domain Services screen, click Next.

VXN W=

At the Confirm installation selections screen, check Restart the destination server automatically if required, and click Install.

Configuring Active Directory and DNS services

1. After the installation completes, a screen should pop up with configuration options. If it does not, click the Tasks flag in the upper-right section of
Server Manager.
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Click Promote this server to a Domain Controller.

At the Deployment Configuration screen, select Add a new forest. In the Root domain name field, type test.local, and click Next.
At the Domain Controller Options screen, leave the default values, and enter a password twice.

To accept default settings for DNS, NetBIOS, and directory paths, click Next four times.

At the Review Options screen, click Next.

At the Prerequisites Check dialog, allow the check to complete. If there are no relevant errors, check Restart the destination server automatically if
required, and click Install.

When the server restarts, log on using test\Administrator and the specified password.

Configuring the Windows Time Service on the domain controller

To ensure reliable time, we pointed our Active Directory server to a local NTP server.

1.
2.

Open a command prompt.
Type the following:

W32tm /config /syncfromflags:manual /manualpeerlist:”<ip address of a NTP server>"
W32tm /config /reliable:yes

W32tm /config /update

W32tm /resync

Net stop w32time

Net start w32time

Preparing AD for Microsoft Exchange

1.

ok wN

8.

Create a reverse lookup zone:

a. Click the start button, and in the search field, type DNS.

Open the DNS manager by clicking on it in the results field.

Expand your Active Directory domain, and click Reverse Lookup Zones.
Click Action>New Zone.

On the Welcome screen, click Next.

Chose Primary Zone, and click Next.

Leave default replication scope, and click Next.

Choose IPv4, and click Next.

i. Enter the IP address of your domain (192.168. 1 for our example).

@ ~0 a0 T

j. Choose Allow both nonsecure and secure dynamic updates, and click Next.
k. Click Finish.

Insert the Exchange 2013 R2 Installation ISO in the AD DVD drive.

In Windows Explorer, double-click the Exchange DVD icon.

In the Exchange installation folder, hold down shift, and right-click.

Choose Open a command window here.

Run the following command:

Setup.exe /PrepareSchema /IAcceptExchangeServerLicenseTerms

When the previous command completes, run the following command:

Setup.exe /PrepareAD /OrganizationName:"”organization name” /IAcceptExchangeServerLicenseTerms

When the setup finishes, close the command window.

Installing Active Directory Certificate Services

Nooas~wDdh =

Launch Server Manager, and select Add roles and features.

At the Add Roles and Features Wizard, click Next.

Select Role-based or feature-based installation, and click Next.

Choose Active Directory Certificate Services.

Click Add Features, if prompted, to install any required features.

Click Next three times.

Choose Certificate Authority and Certification Authority Web Enrollment.
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8.
9.

10.
11.
12.

13

17

Click Add Features, if prompted, to install any required features.

Click Next.

Leave defaults, and click Next.

Click Install.

When the install finishes, click Close.

. Click the yellow warning symbol in the Server Manager, and click Configure Active Directory Certificate Services.
14.
15.
16.

Leave defaults, and click Next.
Check both Certification Authority and Certification Authority Web Enrollment, and click Next.
Choose Enterprise CA, and click Next.

. Choose Root CA, and click Next.
18.
19.
20.
21.
22.
23.
24,
25.

Choose Create a new private key, and click Next.

Leave defaults, and click Next.

Leave defaults, and click Next.

Leave 5 years, and click Next.

Leave default locations, and click Next.

Click Configure.

When the configuration finishes, close the window.

Open Internet Explorer®, and navigate to localhost/certsrv/Default.asp to verify that the installation succeeded.

Installing lometer

NoasrwDd -~

Download the lometer 1.1.0 package for Windows from www.iometer.org/doc/downloads.html.
Double-click the installer, and click Run.

At the Welcome window, click Next.

At the License Agreement window, click | Agree.

At the Choose Components window, leave the defaults selected, and click Next.

At the Choose Install Location window, leave it at defaults, and click Install.

When the installation is complete, click Finish.

Setting up the lometer workload

We used the following settings for each test:

1.
2.

No oA~

Open lometer.exe.

Create the following access specification:

Transfer Delay: Oms

Burst Length: 1 1/0

Outstanding 1/Os: 1

Under Reply Size, select No Reply.

100% random

80% reads

g. Under Align I/Os, select Sector Boundaries.

Under Disk Targets, set the number of Outstanding I/Os to 1.
Set the disk size to 209715200 (100 GB).

Under Results Display, make sure that lometer has selected Start of Test.

-0 Q0 T O

Under Test Setup, set the Run Time to 60 minutes and the Ramp Up Time to 600 seconds.
Exit lometer.

Configuring the Microsoft Exchange 2013 Server

Joining the domain

NoasrwDdh =

Set a static IP.

Select Start>Control Panel>Network Connections>Local Area Connection.

Click Properties.

Highlight Internet Protocol (TCP/IP), and click Properties.

Select Use the following DNS server addresses, and enter the IP of the DNS server in the Preferred DNS server field. Click OK.
Right-click My Computer, and select Properties.

Under the Computer Name tab, click Change.
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8. In the Computer Name Changes screen, under the Member of section, select Domain, and type test.local

9. To start joining the domain, select OK.

10. When the screen appears asking for a person qualified on the domain, type Administrator as the username and Passwordl as the password.
11. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to take effect, click OK.

12. At the System Properties screen, click OK.

13. When a pop-up appears asking if you want to restart now, to restart your computer, click Yes.

Installing Exchange Server 2013 SP1 Mailbox and Client Access Server roles

For the legacy environment, we created large dedicated LUNs on the Dell EqualLogic PS6110 for the Exchange
database, logs, and backup. For the upgraded environment, we added a 110GB VMDK for the database, a 10GB VMDK
for logs, and a 110GB VMDK for backup to the Exchange VM using the Dell Storage SC4020 datastore and the VSAN
datastore.

1. On the Exchange Server, log into the server using domain administrator credentials.
2. Open Windows PowerShell®, and run the following command:

Install-WindowsFeature AS-HTTP-Activation, Desktop-Experience, NET-Framework-45-Features, RPC-over-HTTP-
proxy, RSAT-Clustering, RSAT-Clustering-CmdInterface, RSAT-Clustering-Mgmt, RSAT-Clustering-PowerShell,
Web-Mgmt-Console, WAS-Process-Model, Web-Asp-Net45, Web-Basic-Auth, Web-Client-Auth, Web-Digest-Auth,
Web-Dir-Browsing, Web-Dyn-Compression, Web-Http-Errors, Web-Http-Logging, Web-Http-Redirect, Web-Http-
Tracing, Web-ISAPI-Ext, Web-ISAPI-Filter, Web-Lgcy-Mgmt-Console, Web-Metabase, Web-Mgmt-Console, Web-
Mgmt-Service, Web-Net-Ext45, Web-Request-Monitor, Web-Server, Web-Stat-Compression, Web-Static-Content,

Web-Windows-Auth, Web-WMI, Windows-Identity-Foundation

Restart the server.

Download the Microsoft Unified Communications Managed API 4.0, Core Runtime 64-bit (go.microsoft.com/fwlink/p/?linkld=258269).
Run UcmaRuntimeSetup.exe.

When the installation completes, click Finish.

Navigate to the location of the Exchange installation media, and double-click Setup.exe.
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At the Check for Updates? screen, check the Connect to the Internet and check for updates checkbox, and click Next.
9. When the updates complete, click Next.

10. At the Introduction screen, click Next.

11. At the License Agreement screen, check to accept the terms, and click Next.

12. At the Recommended Settings screen, check Don't use recommended settings, and click Next.

13. At the Server Role Selection, select Mailbox and Client Access role, and click Next.

14. At the Installation Space and Location screen, leave the default location for the installation, and click Next.

15. To disable the Malware Protection Settings, select Yes, and click Next.

16. At the Readiness Checks screen, allow the verification to complete. If there are no failures, click Install.

17. When the installation completes, click Finish, and restart the server.

Configuring Exchange
On the Exchange server, open the Exchange Admin Center by using a browser and navigating to https://localhost/ecp
Enter the domain administrator credentials, and click Sign in.
If prompted, select the language and time zone, and click Save.
In the left pane, click Mail Flow, and then click Send Connectors.

2

3

4

5. On the Send Connectors page, click the New icon.

6. Inthe New Send Connector wizard, specify SMTP as the name, and select Internet as the type. Click Next.
7. In the Network settings screen, choose MX record associated with recipient domain, and click Next.
8. In the Address space screen, click the Add icon.

9. In the Add domain window, type * in the Fully Qualified Domain Name (FQDN) field, and click Save.
10. Click Next.

11. In the Source Server screen, click the Add icon.

12. In the Select a Server window, select the Exchange server, click Add, and click OK.

13. Click Finish.

14. In the left pane of the EAC, click servers, select the name of the Exchange server, and click Edit.

15. Click Outlook Anywhere, and enter the appropriate FQDN of the Client Access Server for the external and internal hostname field. For example,
exchangeserver.test.local

16. As the authentication method, choose NTLM, and click Save.
17. Click Virtual Directories, and then click the Configure external access domain icon.
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18. In the Select the Client Access servers to use with the external URL window, click the Add icon.

19. Select the Exchange server, and click Add. Click OK.

20. Enter the FQDN of the Exchange server in the Enter the domain field, and click Save.

21. Log into the Active Directory server using administrator credentials, and complete the following steps:
a. Open Server Manager, then click Tools>DNS.
b. In the left pane of DNS Manager, expand the Active Directory server name->Forward Lookup Zones->test.local.
c. Inthe right pane, verify or create the DNS records as presented below.

DNS records

Host or child domain/alias

Type FQDN FQDN of mail server
name
Mail Exchanger (MX) Leave blank test.local exchangeserver.test.local
Alias (CNAME) Autodiscover Autodiscover.test.local exchangeserver.test.local
Alias (CNAME) Owa Owa.test.local exchangeserver.test.local

22. Log into your Exchange server.
23. In the Exchange PowerShell, run the following commands, replacing $HostName with the host name (not FQDN) of your Exchange server:

Set-EcpVirtualDirectory “$HostName\ECP (Default Web Site)” -InternalUrl ((Get-EcpVirtualDirectory
“SHostName\ECP (Default Web Site)”) .ExternalUrl)

Set-WebServicesVirtualDirectory “$HostName\EWS (Default Web Site)” -InternalUrl ((get-
WebServicesVirtualDirectory “$HostName\EWS (Default Web Site)”) .ExternalUrl)

Set-ActiveSyncVirtualDirectory “S$HostName\Microsoft-Server-ActiveSync (Default Web Site)” -InternalUrl
((Get-ActiveSyncVirtualDirectory “$HostName\Microsoft-Server-ActiveSync (Default Web Site)”) .ExternalUrl)

Set-OabVirtualDirectory “$HostName\OAB (Default Web Site)” -InternalUrl ((Get-OabVirtualDirectory
“SHostName\OAB (Default Web Site)”) .ExternalUrl)

Set-OwaVirtualDirectory “$HostName\OWA (Default Web Site)” -InternalUrl ((Get-OwaVirtualDirectory
“SHostName\OWA (Default Web Site)”) .ExternalUrl)

Set-PowerShellVirtualDirectory “$HostName\PowerShell (Default Web Site)” -InternalUrl ((Get-
PowerShellVirtualDirectory “$HostName\PowerShell (Default Web Site)”) .ExternalUrl)

Get-0OfflineAddressBook | Set-OfflineAddressBook -GlobalWebDistributionEnabled $True -VirtualDirectories
SNull

Get-OutlookAnywhere | Set-OutlookAnywhere -ExternalHostname exchangeserver.mail.local -InternalHostname
exchangeserver.mail.local -ExternalClientsRequireSsl S$true -InternalClientsRequireSsl S$true
-DefaultAuthenticationMethod NTLM

24. Create a folder at the root of C: on the Exchange server, and share it to Everyone with read/write permissions.
25. Log into the Exchange admin center, and navigate to Servers>certificates.

26. In the drop-down menu, choose the Exchange server, and to create a new certificate, click the plus sign.

27. Choose Create a request for a certificate from a certification authority, and click Next.

28. Name the certificate, and click Next.

29. Do not request a wildcard certificate, and click Next.

30. Click Browse, choose the Exchange server, and click OK. Click Next.

31. Leave defaults, and click Next.

32. Leave defaults, and click Next.

33. Enter your organization information, and click Next.
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34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44.
45.
46.
47.
48.
49.
50.
51.
52.
53.
54.

55.
56.
57.
58.
59.
60.

61.
62.

Enter the path to the share you created on the Exchange server, and click Finish. Example: \\exchange\share\myrequest .REQ
Log into the AD server, and open Internet Explorer.

Browse to localhost/CertSrv

Click Request a certificate.

Choose advanced certificate request.

Choose Submit a certificate request by using a base-64-endcoded CMC...

Open Windows Explorer, and navigate to the share folder on the Exchange server where the certificate request is stored.
Open the certificate with Notepad, and copy the content between BEGIN NEW CERTIFICATE REQUEST and END NEW CERTIFICATE REQUEST.
Paste the copied content into the Saved Request window.

Choose Web Server in the Certificate Template drop-down menu, and click Submit.

Choose Base 64 encoded, and download the certificate.

Copy the new certificate into the share folder on the Exchange server.

Log into the Exchange server and open the Exchange Admin Center.

Go to Servers>Certificates, and highlight the certificate you began before (it should read “Pending request” in the status column).
On the right side, click Complete.

Enter the path to the certificate, including the certificate name, and click OK. Example: \\exchange\share\certnew.CER
Verify that the status has changed to Valid.

Edit the new entry, and click Edit.

Go to Services, check SMTP and IIS, and click Save.

On the warning message, click Yes.

Run the following steps on the Exchange and AD servers:

Click Start, and type MMC

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates>Trusted Root Certificate Authorities>Certificates.

Click Action>All Tasks=>Import.

Click Next.

Browse to the share folder on the Exchange server, and choose the new certificate you created. Click Next.
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k. Leave defaults, and click Next.

I Click Finish.

m. On the Import was successful message, click OK.

Log into the Exchange server, and open the Exchange admin center.

Navigate to Servers->Databases.

On the MB server, restart the Microsoft Exchange Information Store service.

Using the Edit button, disable the maintenance schedule, and enable circular logging for each mailbox database.
Dismount and remount the databases.

Open the Exchange Management shell, and type the following to move the paths of the default mailbox:

Move-Databasepath “DatabaseName” —EdbFilepath “E:\Newlocation\DBname.edb” —LogFolderpath “F:\Newlocation”

When prompted, type 2, and press Enter.
Open Exchange Management Shell, and type the following:

Get-OutlookAnywhere |Set-OutlookAnywhere -ExternalHostname exchange.domain.com
-DefaultAuthenticationMethod NTLM -ExternalClientsRequireSsl $true

Configuring the Microsoft SQL Server 2014 server

For the legacy environment, we created large dedicated LUNs on the Dell EqualLogic PS6110 for the SQL database,
logs, and backup. For the upgraded VMware environment, we added a 60GB VMDK for the database, a 30GB VMDK for
logs, and a 50GB VMDK for backup to the SQL VM using the Dell Storage SC4020 datastore and the VSAN datastore.

Installing SQL Server 2014 with Service Pack 1

1.
2.

Prior to installing, add the .NET Framework 3.5 feature to the server.
Mount the installation SQL Server 2014 DVD.
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Click Run SETUP.EXE. If Autoplay does not begin the installation, navigate to the SQL Server 2014 DVD, and double-click it.
In the left pane, click Installation.

Click New SQL Server stand-alone installation or add features to an existing installation.

Select Enter the product key, and enter the product key. Click Next.

Click to accept the license terms, and click Next.

Click Use Microsoft Update to check for updates, and click Next.

9. To install the setup support files, click Install.
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10. If there are no failures displayed, click Next.
11. At the Setup Role screen, choose SQL Server Feature Installation, and click Next.

12. At the Feature Selection screen, select Database Engine Services, Full-Text and Semantic Extractions for Search, Client Tools Connectivity, Client
Tools Backwards Compatibility, Management Tools — Basic, and Management Tools — Complete. Click Next.

13. At the Installation Rules screen, after the check completes, click Next.
14. At the Instance configuration screen, leave the default selection of default instance, and click Next.

15. At the Server Configuration screen, choose NT Service\SQLSERVERAGENT for SQL Server Agent, and choose NT Service\MSSQLSERVER for SQL
Server Database Engine. Change the Startup Type to Automatic. Click Next.

16. At the Database Engine Configuration screen, select the authentication method you prefer. For our testing purposes, we selected Mixed Mode.
17. Enter and confirm a password for the system administrator account.

18. Click Add Current user. This may take several seconds.

19. Click Next.

20. At the Error and usage reporting screen, click Next.

21. At the Installation Configuration Rules screen, check that there are no failures or relevant warnings, and click Next.

22. At the Ready to Install screen, click Install.

23. After installation completes, click Close.

24. Run through the installation again, creating a new installation of SOL with the same settings.

25. Close the installation window.

Generating the DVD Store 2 data

We generated the data using the Install.pl script included with DVD Store version 2.1 (DS2), providing the parameters for
our 40GB database and the Microsoft SQL Server 2014 platform. We ran the Install.pl script on a utility system running
Linux®. The Install.pl script also generated the database schema.

After processing the data generation, we transferred the data files and schema creation files to a Windows-based system
running SQL Server 2014. We built the 40GB database in SQL Server 2014, then performed a full backup, storing the
backup file on the SQL backup LUN for quick access. We used that backup file to restore the server between test runs.

The only modifications we made to the schema creation scripts were the specified file sizes for our database. We
explicitly set the file sizes higher than necessary to ensure that no file-growth activity would affect the output of the
test. Apart from this file-size modification, we created and loaded the database schema according to the DVD Store
documentation. Specifically, we followed these steps:

1. Using database creation scripts in the DS2 download, generate the data, and create the database and file structure. Make size modifications
specific to the 40GB database, and make the appropriate changes to drive letters.

Transfer the files from a Linux data-generation system to a Windows system running SQL Server.
Create database tables, stored procedures, and objects using the provided DVD Store scripts.
To prevent excess logging, set the database recovery model to bulk-logged.
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Load the generated data into the database. For data loading, use the import wizard in SQL Server Management Studio. Where necessary, retain
options from the original scripts, such as Enable Identity Insert.

o

Create indices, full-text catalogs, primary keys, and foreign keys using the database-creation scripts.
7. Update statistics on each table according to database-creation scripts, which sample 18 percent of the table data.
8. To create a ds2user SQL Server login on the SQL Server instance, use the following Transact-SQL (T-SQL) script:

USE [master]

GO

CREATE LOGIN [ds2user] WITH PASSWORD=N'"',
DEFAULT_DATABASE=[master],
DEFAULT LANGUAGE=[us_english],
CHECK_EXPIRATION=OFF,
CHECK_POLICY=0OFF

GO
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9. Set the database recovery model back to full.

10. Using SQL Server Management Studio, create the necessary full text index.

11. Create a database user, and map this user to the SQL Server login.

12. Perform a full backup of the database. This backup allows a restore of the database to a pristine state relatively quickly between tests.

Our initial file size modifications

Filegroup Initial size (MB)
3

primary PRIMARY
cust1 DS_CUST_FG
cust2 DS_CUST_FG
cust3 DS_CUST_FG
custd DS_CUST_FG
ind1 DS_IND_FG
ind2 DS_IND_FG
ind3 DS_IND_FG
ind3 DS_IND_FG
ds_misc DS_MISC_FG
orders1 DS_ORDERS
orders2 DS_ORDERS
orders3 DS_ORDERS
orders4 DS_ORDERS
Log files

ds_log N/A

Upgraded Dell PowerEdge FC430 environment

6,144

6,144

6,144

6,144

3,280

3,280

3,280

3,280

200

3,072

3,072

3,072

3,072

25,375

We used the following steps to configure the Dell PowerEdge FC430 environment with VMware vSphere and VSAN.

For the backing storage, we created a VSAN datastore using the SSDs in the FD332 trays. In the last scenario of testing,
we created an 18TB LUN on the Dell Storage SC4020 and mapped the LUN to our PowerEdge FC430 servers via fibre
channel. Once the virtual infrastructure was in place, we used the same steps from the legacy environment to create VMs

identical to each server role.

Installing VMware ESXi 6 Update 2

Attach the installation media.

Boot the server.

At the VMware Installer screen, press Enter.

At the EULA screen, to Accept and Continue, press F11.

Under Storage Devices, select the appropriate virtual disk, and press Enter.
As the keyboard layout, select US, and press Enter.

Enter the root password twice, and press Enter.

To start installation, press F11.
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After the server reboots, press F2, and enter root credentials.
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10. Select Configure Management Network, and press Enter.

11. Select the appropriate network adapter, and select OK.

12. Select IPv4 settings, and enter the desired IP address, subnet mask, and gateway for the server.
13. Select OK, and restart the management network.

14. Repeat steps 1 through 13 on all 24 servers.

Deploying the VMware vCenter Server 6 Update 2

We used a client server running VMware ESXi to host our clients and virtualized management servers. For the VMware
vCenter server VM, we installed Windows Server 2012 R2 and performed the following steps to install and configure

vCenter.

1. Log into the vCenter VM.

2. From the VMware vCenter Server 6.0 install media, click Run to start the install wizard.

3. Select vCenter Server, and click Install.

4. At the Install wizard welcome screen, click Next.

5. Agree to the License Agreement, and click Next.

6. Select the Embedded Deployment option and click Next.

7. Enter the system IP address.

8. Enter and confirm the password you wish to use with the Administrator account for vCenter Single Sign On, and click Next.

0

Click Next.

10. Accept the default database settings, and click Next.

11. Accept the default https port, and click Next.

12. Accept the default installation path, and click Next.

13. Uncheck Join the VMware Customer Experience Improvement Program, and click Next.
14. Click Install.

15. To exit the wizard, click Finish.

16. On the installer, click Exit.

17. Restart the server.

18. Once completed, log into the first vCenter’s web client at https://vcenter-ip-address/vsphere-client/?csp.
19. Add all the necessary ESXi and vCenter licenses to the vCenter.

Creating the cluster and adding the hosts to VMware vCenter

We used the following steps to create each of the three clusters in each site and add the desired servers to the vCenter.
The clusters on each site are management, edge, and compute.

Once logged into the vCenter, navigate to Hosts and Clusters.
Select the primary site management vCenter.

Right-click the vCenter object, and select New Datacenter...
Enter a name for the new datacenter, and click OK.

Right-click the new datacenter, and click New Cluster...

Enter a name for the new cluster.

Expand Virtual SAN, and turn on Virtual SAN.

Click the drop-down menu, and set it to Manual.
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9. Click OK.
10. Once the cluster has been created, right-click the cluster, and click Add Host.
11. Enter the IP address for the first PowerEdge FC430 server, and click Next.

—_
N

. Enter the root credentials for the server, and click Next.

—_
w

. To accept the server’s certificate, click Yes.

N
~

. Review the server details, and click Next.

—
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. Assign the desired license, and click Next.

-
o~

. Disable Lockdown mode, and click Next.
. Click Finish.
. Repeat steps 10 through 17 for the remaining PowerEdge FC430 servers.

_
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. Once all the servers are added to the cluster, right-click a host, and click Storage>New Datastore.
. Select VMFS, and click Next.
. Enter a name for the new datastore, select the Dell Storage SC4020 LUN, and click Next.
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22. Accept the defaults for the partition configuration, and click Next.

23.
24.

Click Finish.
Once the create datastore task is complete, ensure that all the hosts in the cluster are mounted on the new datastore.

Configuring the VMware vSphere Distributed Switch for the cluster

For our networking configuration, we utilized vSphere Distributed Switches for the cluster. We then created port groups:
Management, vMotion, VSAN, and a port group for each Exchange VM network. Each port group utilized VLANSs: 128 for
Management, 980 for vMotion, 990 for VSAN, and 1001 through 1032 for Exchange.
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33.
34.
35.
36.
37.
38.
39.
40.
41.
42.
43.
44.
45.
46.
47.

Navigate to the Networking tab.

Expand the vCenter for the cluster.

Right-click the datacenter, and click Distributed Switch->New Distributed Switch.
Enter a name for the vDS, and click Next.

Select Distributed switch: 6.0.0, and click Next.

Set the number of uplinks to two, and enter a name for the new default port group.
Click Next.

Review the settings, and click Finish.

Select the new vDS, and click the manage tab.

. Under Properties, click Edit...

. Click Advanced, and for the MTU setting, type 9000.

. Click OK.

. On the left-hand side, right-click the new port group that was created along with the new vDS.
. Click Edit Settings.

. Click VLAN, and for the VLAN (for the management port group), type 128.

. Click Teaming and Failover.

. Set all the two uplinks to active.

. Click OK.

. Right-click the vDS, and click Distributed Port Group>New Distributed Port Group.
. Enter a name for the new port group (e.g., vMotion), and click Next.

. Under VLAN, set the VLAN to 980 for vMotion.

. Under Advanced, check Customize default policies configuration.

. Click Next.

. For Security, click Next.

. For Traffic Shaping, click Next.

. For Teaming and Failover, assign the two uplinks as active ports.

. Click Next.

. For Monitoring, click Next.

. For Miscellaneous, click Next.

. For Edit additional settings, click Next.

. Review the port group settings, and click Finish.

. Repeat steps 19 through 31 to create individual port groups for VLANs 1001 through 1032. These will be used for individual Exchange environment

networks and a port group for VSAN using VLAN 990.

Right-click the vDS, and click Add and Manage Hosts...

Select Add hosts, and click Next.

Click + New hosts...

Select all the hosts in the vCenter, and click OK.

Click Next.

Select Manage physical adapters and Manage VMkernel adapters, and click Next.
For each host, select each of the two 10Gb ports, click Assign uplink, and assign them to the two uplink ports.
Click Next.

Select the first host, and click +New adapter.

Click an existing network, and click Browse.

Select the vMotion port group, and click OK.

Click Next.

Check the vMotion traffic box, and click Next.

Enter the desired network information for the new VMKernel, and click Next.
Click OK.
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48. Select the new adapter, and click Edit adapter.

49. Click NIC settings.

50. Set the MTU to 9000.

51. Click OK.

52. Select the first host, and click +New adapter.

53. Click select an existing network, and click Browse.

54. Select the VSAN port group, and click OK.

55. Click Next.

56. Check the VSAN traffic box, and click Next.

57. Enter the desired network information for the new VMKernel, and click Next.
58. Click OK.

59. Select the new adapter, and click Edit adapter.

60. Click NIC settings.

61. Set the MTU to 9000.

62. Click OK.

63. Select each of the remaining hosts individually, and repeat steps 42 through 62 for each.
64. Click Next.

65. Analyze the impact, and click Next.

66. Review the settings, and click Next.

Configuring Virtual SAN for each cluster

Once the VSAN network was in place, we used the following steps to configure VSAN.

67. Log into the vCenter web client, and navigate to Hosts and Clusters.

68. Expand the primary site management vCenter, and select the management cluster.
69. Click Manage, and under Settings—>Virtual SAN, click Disk Management.

70. Click Claim Disks.

71. vCenter separates the disks into groups based on type. For the group of Intel S3710 series SSDs, select Cache Tier. For the group of Intell S3510
series SSDs, select Capacity.

72. Click OK.

Creating the VMs

We created three gold image VMs for each of the workloads: SQL, Exchange, and AD with lometer. We then used
these gold images to clone out three workloads multiple times until we reached capacity on our storage and VSAN
recommended capacity for a single-node failure. We created 32 sets of the legacy environment.

In VMware vCenter, navigate to Virtual Machines.
To create a new VM, click the icon.
Leave Create a new virtual machine selected, and click Next.
Enter a name for the virtual machine, and click Next.
Place the VM on the desired host with available CPUs, and click Next.
Select the Dell Storage SC4020 datastore or the VSAN datastore for the 40GB OS VMDK, and click next.
Click Next.
Select the guest OS as Windows Server 2012 R2, and click Next.
In the Customize Hardware section, use the following settings for each VM type:
a. Forthe SQL VM:
i. Setthe vCPU count to 4.

ii. Setthe Memory to 24GB, and check Reserve all guest memory. For the scenario using the external storage array, lower the RAM to
12GB.

iii. Add a 60GB VMDK for the database, a 30GB VMDK for logs, and a 50GB VMDK for SQL backup.
iv. For the NIC connection, select the default VM Network.
v. Attach a Windows Server 2012 R2 ISO to the CD/DVD drive.
b. For the Exchange VM:
i. Setthe vCPU count to 4.
ii. Setthe Memory to 12GB, and check Reserve all guest memory. For the scenario using the external storage array, lower the RAM to 8GB.
iii. Adda 110GB VMDK for the database, a 10GB VMDK for logs, and a 110GB VMDK for Exchange backup.
iv. Select the VLAN 1001 port group for the network adapter connection. This setting will change for each cloned Exchange VM in the order
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of VLAN 1002, VLAN 1003, etc.
v. Add a second network adapter, and set the connection to the default VM Network.
vi. Attach a Windows Server 2012 R2 ISO to the CD/DVD drive.
c. Forthe AD/lometer VM:
i. Setthe vCPU count to 4.
ii. Setthe Memory to 2GB, and check Reserve all guest memory.
iii. Add a 120GB VMDK for lometer.

iv. Select the VLAN 1001 port group for the network adapter connection. This setting will change for each cloned AD/lometer VM in the
order of VLAN 1002, VLAN 1003, etc.

v. Add a second network adapter, and set the connection to the default VM Network.
vi. Attach a Windows Server 2012 R2 ISO to the CD/DVD drive.
10. Click Next.
11. Click Finish.
12. Power on the VMs, and follow the steps outlined in the Legacy Environment section to install and configure each workload.

13. Once each configuration is complete, clone out all three VMs until capacity is reached on the VSAN datastore for the first two scenarios. Clone out
all three VMs until capacity is reached on the Dell Storage SC4020 datastore for the third scenario.

Configuring the clients and running the test
We ran all test clients on a server running a hypervisor. We used the following steps to configure each client VM.

Installing and configuring the Microsoft Exchange 2013 mail test clients and completing LoadGen configuration on
Exchange 2013

For our testing, we used one virtual client machine to run LoadGen 2013. To create the mail clients, we installed several
software components. We followed this process for each installation:

Installing Windows Server 2012 R2

Insert the installation media into the CD/DVD drive, and restart the server.

When prompted to boot from DVD, press any key.

When the installation screen appears, click My language is English (United States).
Leave language, time/currency format, and input method as default, and click Next.
Click Install now.

When the installation prompts you, enter the product key.

Select Windows Server 2012 R2 Datacenter (Server with a GUI), and click Next.
Check | accept the license terms, and click Next.
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9. Click Custom: Install Windows only (advanced).

10. Select Drive 0 Unallocated Space, and click Next.

11. When the Settings page appears, fill in the Password and Reenter Password fields with the same password.
12. Log in with the password you set up previously.

To set up this server, we had to install several additional software components. The following subsections detail the
necessary installation processes.

Joining the domain

1. Set a static IP.

2. Select Start>Control Panel>Network Connections—>Local Area Connection.

3. Click Properties.

4. Highlight Internet Protocol (TCP/IP), and click Properties.

5. Select Use the following DNS server addresses, and enter the IP of the DNS server in the Preferred DNS server field. Click OK.
6. Right-click My Computer, and select Properties.

7. Under the Computer Name tab, click Change.

8. In the Computer Name Changes screen, select the Domain under the Member of section, and type test.local

9. To start joining the domain, select OK.

—
o

. When the screen appears asking for a person qualified on the domain, type Administrator as the username and Passwordl as the password.

—_
N

. At the Welcome pop-up window and the window warning that you must reset the computer for the changes to take effect, click OK.

—_
N

. At the System Properties screen, click OK.

—_
w

. When a pop-up appears asking if you want to restart now, click Yes.
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Installing Internet Information Services
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9.

10.
11.
12.

Click Start->Administrative Tools->Server Manager.

On the left pane, click Roles.

Click Add Roles.

Click the Application Server checkbox.

When the Add features required for Application Server? screen appears, click Add Required Features.
Click Next twice.

At the Select Role Services page for Application Server, click Web Server (IIS) Support.

Click Add Required Support Role Services.

Click Next twice.

At the Select Role Services page for Web Server (IIS), click the IS 6 Management Compatibility, ASP, and CGI checkboxes, and click Next.
Click Install.

Click Close.

Importing the certificate and editing the hosts file

Click Start, and type MMC

Click File>Add/Remove Snap-in.

Choose Certificates, and click Add.

Choose Computer account, and click Next.

Choose Local computer, and click Finish.

Click OK.

Expand Certificates>Trusted Root Certificate Authorities>Certificates.
Click Action>All Tasks=>Import.

Click Next.

. Browse to the share folder on the Exchange server, and choose the new certificate you created. Click Next.

. Leave defaults, and click Next.

. Click Finish.

. On the Import was successful message, click OK.

. Open the Notepad program, and use File->Open to open the hosts file stored at C:\Windows\System32\drivers\etc.
. Add the IP and FQDN of the Exchange server.

. Save the file, and close Notepad.

Preparing Load Generator
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8.

9.

10.
11.
12.
13.
14.
15.

Log into the mail client.

Using all defaults, download and install Load Generator 2013.

Select Start->All Programs->Microsoft Exchange->Exchange Load Generator 2013.
When the Load Generator screen appears, select Start a new test.

Select Create a new test configuration, and click Continue.

Change the total length of simulation to one hour.

In the Specify test settings screen, type Passwordl as the Directory Access Password and Mailbox Account Master Password, and click Continue
with recipient management.

Create 500 users in the Mailbox Database, and click Continue.

To accept defaults for Advanced recipient settings, click Continue.

In the Specify test user groups screen, select the plus sign to add a user group.

Change the Client Type to Outlook 2007 Cached, the action profile to Outlook_250, and the Mailbox size to 250 MB, and click Continue.
In Remote configurations, leave the checkbox to enable distributing the workload unchecked, and click Continue.

Click Save the configuration file as, and name it testcfg.xml

Click Start the initialization phase (recommended before running the test).

After the database initializes, create a backup copy of the Exchange mailbox databases.

Configuring the database workload client

For our testing, we used a virtual client for the Microsoft SQL Server client. To create this client, we installed Windows
Server 2012 R2 and assigned a static IP address. We then copied over the DS2 driver executable and the associated test
scripts.
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Running the tests

We ran all three tests simultaneously, using a script to start the final step of each of the following methodologies. If
necessary, run them manually.

Running the DVD Store test

We created a series of batch files, SQL scripts, and shell scripts to automate the complete test cycle. DVD Store outputs
an orders-per-minute (OPM) metric, which is a running average calculated through the test. In this report, we report the
last OPM reported by each client/target pair.

Each complete test cycle consisted of the following general steps:

Clean up prior outputs from the target system and the client driver system.
Drop the database from the target.

Restore the database on the target.

Shut down the target.

Reboot the system under test and the client system.

Wiait for a ping response from the system under test and from the client system.
Let the system under test idle for 10 minutes.

. Start the DVD Store driver on the client.

NG R wN 2

We used the following DVD Store parameters for testing:

ds2sglserverdriver.exe --target=<target IP> --ramp rate=10 --run_time=60 --n_threads=16 --db_
size=40GB --think time=0.100 --detailed view=Y --warmup_ time=10 --report rate=5 --csv_output=<drive path>

Running the lometer test

1. Reboot the system under test.

2. Login, and let the system idle for 10 minutes.

3. Open lometer, and load the test file created earlier during setup.
4. To kick off the lometer test, click Start.

Running Load Generator

Log into the mail client.

Select Start>All Programs—>Microsoft Exchange>Exchange Load Generator 2013.

When the Load Generator screen appears, select Start a new test.

Select load a test configuration, and click Continue.

Leave the settings at their already determined settings, and click continue until you get to the last stage.

ok whN =

After 10 minutes, click Skip initialization and start test.

Installing and configuring the management tools

We used the following steps to configure our management tool VMs for Dell Performance Analysis Collection Kit and
Dell OpenManage Essentials on the client servers. Each VM started with a base install of Windows Server 2012 R2.

Installing and configuring Dell OpenManage Essentials
1. Download Dell OpenManage Essentials. Open the installation media.
2. Leave Dell OpenManage Essentials checked, and click Install.

3. At the Critical Prerequisites screen, click Install All Critical Prerequisites. When the warning dialog appears, click Yes to continue installation of the
critical prerequisites.

4. At the next prerequisites screen, click Install Essentials. To install Essentials on a local database, click Yes.
5. Click Install Essentials.

6. Accept the license agreement for Dell OpenManage Essentials, and click Next.

7. Leave the Typical setup type selected, and click Next.

8. Review the installation settings, and click Install.

9. When installation completes, leave Launch Dell OpenManage Essentials checked, and click Finish.

10. When Dell OpenManage Essentials launches, click Manage.

11. Click Discovery and Inventory.

12. Click Add Discovery Range.

13. At the Discovery Range Configuration wizard, enter the IP address range for the first Dell servers.
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14. Click Add.

15. Click Next.

16. Leave the default Timeout and Retries ICMP parameters, and click Next.

17. Ensure the WS-Man discovery type is selected, and click Next.

18. Type the iDRAC User ID and Password for discovery (root / calvin). Ensure that Secure Mode and Trusted Site are checked, and click Next.
19. Review the summary, and click Finish.

20. From the Manage tab, click Discovery and Inventory.

21. Click Add Discovery Range.

22. At the Discovery Range Configuration wizard, enter the IP address range for the second Dell server.

23. Click Add.

24. Click Next.

25. Leave the default Timeout and Retries ICMP parameters, and click Next.

26. Ensure the WS-Man discovery type is selected, and click Next.

27. Type the iDRAC User ID and Password for discovery (root / calvin). Ensure that Secure Mode and Trusted Site are checked, and click Next.
28. Review the summary, and click Finish.

Configuring Dell Performance Analysis Collection Kit (DPACK)

For this report, Dell gave us a DPACK account to download the tool and upload DPACK projects. We followed the steps
below to perform DPACK data collection for each environment.

Download the Windows DPACK executable file to a Windows Server 2012 R2 client system.

Launch the executable file.

To agree to the license terms, click Yes.

Review the customer data, and click Yes.

To automatically upload DPACK collections to the web account, select Establish a secure (HTTPS) connection to the DPACK Web Service.
To generate a local IOKIT file, select Do not connect to the DPACK Web Service.

Click OK.

If DPACK has been configured previously, it will prompt you to decide if you want to use the previous setting. Click No.
Select the local drive listed, and click Ignore Disk.

0. Click Add Remote Server.

1

. For the legacy environment, select Connect to a Windows server, and enter the IP of the first server. Then click Connect, and enter in the login
credentials of the server. Repeat these steps to add the remaining two servers.
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12. For the upgraded FX2 and VSAN environment, select Connect to a VMware vCenter Server, and enter the IP address of the vCenter server. Then
click Connect. Click OK at the warning, and enter in the vCenter credentials. Select the FC430 cluster, and click OK.

13. Once all desired servers are connected, select any undesired disks from the list, and click Ignore Disk.
14. Change the capture duration to four hours.
15. Click Start capture.

Note: For our testing, we started the capture right before kicking off each test run. We cancelled the capture at the end
of roughly one hour, capturing data only when the servers were under load.

Installing and configuring VMware vRealize Operations Manager (vVROPS)
Installing vROPS

Download the vRealize Operations Manager Appliance from VMware.

Open a browser, and connect to the vSphere Web Client.

Enter administrative credentials, and click Login.

In the left menu pane, click vCenter.

In the left menu pane, click Hosts and Clusters.

At the top of the center pane, select Actions->Deploy OVF Template...

Select Local File, and to locate the vRealize Operations Appliance OVA file, click the Browse button. Select the file, and click Open. Click Next.
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Check Accept extra configuration options, and click Next.

9. To accept the EULA, click Accept, and click Next.

10. Select the vSphere datacenter to which you want to deploy the appliance, and click Next.

11. Accept the default configuration Small, and click Next.

12. Select the virtual disk format Thin Provision. Choose the datastore for housing the virtual machine files, and click Next.
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13. Select the destination virtual network from the pull-down list, and click Next.

14. In Customize template, select Networking Properties and provide the IP address information for the virtual machine. Leave it blank if you prefer to
use DHCP. Click Finish.

Configuring vROPS

When the initialization process completes, enter the username admin and the password you created for that user. Click Login.

1. Power on the virtual machine, and open the console in vSphere client.

2. Verify the IP address of the vROPs server, open a web browser, and connect to the vROPs page to begin configuration.
3. Click Express Installation.

4. Click Next.

5. Enter and re-enter a password for the default admin user. Click Next.

6. Click Finish.

7.

8.

Continue the configuration by clicking Next.

0

To accept the terms of the agreement, check the box, and click Next.

—
o

. Enter the product key or accept the default for a product evaluation, and click Next.

. Click Next.

. Click Finish.

. In the solutions section, select the VMware vSphere solution. To configure, click the gears icon in the top of that section.

- a a
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. Select vCenter Adapter. For Instance settings, enter a display name and a description. Enter the vCenter Server address, and to add a new
credential, click the green plus sign.

15. Enter a credential name, like vCenter Administrator, and enter the username and password for the user. We used administrator@vsphere.local and
the relevant password. Click OK.

16. Click Test Connection.

17. To accept the certificate, click OK. Click OK.
18. Click Save Settings. Click OK.

19. Select the vCenter Python Actions Adapter.

20. Select vCenter Adapter. For Instance settings, enter a display name and a description. Enter the vCenter Server address, and to add a new
credential, click the green plus sign.

21. Enter a credential name, such as vCenter Administrator, and enter the username and password for the user. We used administrator@vsphere.local
and the relevant password. Click OK.

22. Click Test Connection.

23. To accept the certificate, click OK. Click OK.

24. Click Save Settings. Click OK.

25. Click Next.

26. Accept default settings for monitoring pools, and click Next.
27. Click Finish.
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Appendix C — Our setup

Legacy environment

For our legacy environment, we configured three identical Dell PowerEdge R710 servers. Each server contained 48

GB of RAM and dual Intel Xeon E5520 processors. We installed Windows Server 2012 R2 with updates on them and
configured each for its individual workload purpose. For the database workload server, we installed SQL Server 2014 SP1
with updates and configured a single SQL instance with a 40GB database for the DVD Store 2 server to target. For the
mailbox workload server, we installed Microsoft Exchange 2013 with updates. We then generated a typical 500-mailbox
environment using a Load Generator 2013 client. Finally, we installed lometer on the third server to simulate file server
work and configured the VM to act as the Active Directory server for the Exchange environment. We cabled all three
servers to a standard 1Gb Ethernet switch using the onboard NICs for client and management traffic. For information on
our test methodology, see Appendix B.

For the backing legacy storage, we configured a Dell EqualLogic PS6110 array with 24 10K HDDs and 10Gb iSCSI
connectivity. We cabled each of the EquallLogic’s controllers to a 10Gb Dell Networking S4810 switch with redundant
paths. We then installed an Intel Ethernet Server Adapter X520 in each PowerEdge R710 and cabled both ports on
each card to the S4810. We configured each port for iSCSI traffic and multipath 1/0 using native Windows tools and the
Equallogic HIT Kit software. We presented each server with individual LUNs on the EqualLogic PS6110 for their specific
workloads: three LUNs for the SQL database, logs, and backups to the database server; three LUNs for the Exchange
mailbox database, logs, and backups to the mailbox server; and one LUN for the lometer work file to the file server. See
below for a detailed diagram of our legacy environment test bed.

Our legacy environment test bed
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Upgraded environment

For our upgraded environment, we configured four identical Dell PowerEdge FC430 server nodes in a Dell FX2 chassis.
Each server node contained 256 GB of RAM and dual Intel Xeon E5-2660 v4 processors. We installed VMware vSphere
6 Update 2 on each server node. For the initial scenario, we created a three-node cluster in VMware vCenter Server. For
the scaling scenario, we added a fourth node to the cluster. Each server node contained a two-port onboard Broadcom
BCM57810 NIC that mapped to two external Dell 10Gb pass-through modules. We cabled each port on the pass-
through modules to a Dell Networking S4810 switch for management, vMotion, and VSAN traffic. We configured all
networks according to VMware best practices.
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For the backing storage of our initial scenario, we set up two Dell PowerEdge FD332 storage modules, each with four
Intel DC S3710 series SSDs for caching and 12 Intel DC S3510 series SSDs for capacity, to support VSAN. For our scaling
scenario, we added and configured a Dell Storage SC4020 array with 12 write-intensive SSDs and 12 mixed-used SSDs.
For storage connectivity, we connected two 8Gb fibre channel ports from each of the two storage controller modules to
a Brocade 300 fibre switch with NPIV enabled. We then installed a QLogic GLE2562 8Gb fibre channel card in each FX2
I/O module attached to each of the PowerEdge FC430 server nodes and cabled both ports to the Brocade switch. We
created a single 18TB LUN on the storage and mapped the LUN to the PowerEdge FC430 server nodes for additional
VM storage with read- and write-cache enabled on the LUN. See below for a detailed diagram of our upgraded
environment test bed.

Our upgraded environment test bed

e 3G fibre
10Gb

Brocade 300

Dell Storage SC4020
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Each server node hosted a mix of database workload VMs, mailbox workload VMs, and file workload VMs, with each VM
matching the software configuration of the legacy servers. Due to load balancing, each PowerEdge FC430 ran eight sets
of legacy workload VMs. We resized the VMs' resources lower than those of the legacy servers to allow for maximum
resource utilization and workload consolidation because our test VMs were performing at the level of the legacy
environment or better. We also reserved all RAM for each VM to avoid memory contention. We kept the storage profile
defaults for all VMDKs. For each VM type, we used the following VM hardware settings:

RAM -4
nodes & Data
Workload storage Os VMDK VMDK LOg YIMDK
(€]3)) (€13)]
(GB)
(GB)

Database 4 24 24 12 40 60 30 50
Mailbox 4 12 12 8 60 110 10 110
File 4 2 2 2 40 120 N/A N/A
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Appendix D — DPACK Screenshots

The following screenshots of the DPACK reports show performance of the upgraded environment with three and four
nodes and the additional scenario combining VSAN and external storage. The data from this hour-long test run serves as

an example of the solution’s performance throughout testing, specifically in regards to CPU utilization, input/output per
second (IOPS), and storage latency.

CPU utilization

The upgraded environment with three FC430 nodes achieved a peak CPU utilization of 38 percent and averaged
approximately 28 percent. This leaves plenty of CPU for additional VMs or for existing VMs.
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With the addition of the fourth FC430 node, the environment CPU utilization peaked at 58.9 percent and averaged
about 35 percent at a steady state. Overall, the infrastructure’s CPU in both cases remained underutilized.
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Our last scenario with additional storage capacity allowed us to further drive up CPU utilization on our hosts. With the
additional storage, CPU utilization peaked at 78.1 percent with an average of about 53 percent at steady state. The CPU
still had headroom for increased VM counts.
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IOPS

With the three-node configuration, the environment peaked at around 82,500 IOPS and averaged about 75,000 IOPS.
VSAN had additional storage capacity that we could have used to increase the number of workloads, but we limited our
environment's storage capacity utilization to allow enough capacity for a single-node failure.
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With the addition of the fourth node, the environment achieved a peak of around 133,000 IOPS and averaged around
110,000 IOPS over the course of the run. By adding the fourth node, we gained additional storage performance and
capacity. Again, we limited our consolidation ratio to allow for a single-node failure.

ops - 0

95th Percentile = 129530 I0PS write10P5 Il Read 10PS W

120000

100000

80000

60000

40000

20000

10:21 10:24  10:27 10:30 10:33 10:36 10:39 10:42 10045 10:48  10:51 10:54  10:57  11:00 11:03 11:06  11:09 11:12 1115 11:18  11:2

Finally, adding the external storage increased CPU utilization on our hosts. The environment peaked at 148,000 IOPS and
averaged around 120,000. At this point, the SC4020 was out of raw storage capacity, which was the only thing limiting
additional consolidation.
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Latency

We considered 20 ms an acceptable threshold for latency during testing. In the three-node configuration, the upgraded
environment's latency peaked at a 1.1ms read and a 0.9ms write. Latency was never an issue as the environment
remained below 1ms for the entire course of the run.
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With the additional fourth node, the upgraded environment latency peaked at just over a 1.6ms read and a 1.1ms write.
Again, latency remained at around 1 ms.
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With the external storage array added to the solution, latency spiked at the start of the test run, peaking at 6.7ms read
and 3ms write, but then dropped and remained around 2ms read and 1.3ms write for the duration of the test. With both
the all-flash VSAN configuration and the all-flash SC4020, high latency was never a concern.
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Additional DPACK counters

DPACK also provides many other graphs showing metrics like memory utilization, network and storage throughput, I/O
size, and more. We did not use these graphs in our analysis. When you examine all the graphs together, the data they
provide can give you a clear picture of your current environment’s performance needs as well as potential bottlenecks

and limitations.
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This project was commissioned by Dell.

Principled Technologies is a registered trademark of Principled Technologies, Inc.
All other product names are the trademarks of their respective owners.

Principled
Technologies®

Facts matter.°

DISCLAIMER OF WARRANTIES; LIMITATION OF LIABILITY:

Principled Technologies, Inc. has made reasonable efforts to ensure the accuracy and validity of its testing, however, Principled Technologies, Inc.
specifically disclaims any warranty, expressed or implied, relating to the test results and analysis, their accuracy, completeness or quality, including any
implied warranty of fitness for any particular purpose. All persons or entities relying on the results of any testing do so at their own risk, and agree that
Principled Technologies, Inc., its employees and its subcontractors shall have no liability whatsoever from any claim of loss or damage on account of any

alleged error or defect in any testing procedure or result.

In no event shall Principled Technologies, Inc. be liable for indirect, special, incidental, or consequential damages in connection with its testing, even if

advised of the possibility of such damages. In no event shall Principled Technologies, Inc.’s liability, including for direct damages, exceed the amounts paid in
connection with Principled Technologies, Inc.’s testing. Customer’s sole and exclusive remedies are as set forth herein.
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